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NOTICE

Read this manual before working with the product. For personal and system safety, and for optimum product performance,
ensure you thoroughly understand the contents before installing, using, or maintaining this product.

For equipment service or support needs, contact your local Emerson Automation Solutions/Rosemount Tank Gauging
representative.
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1 Overview

1.1 Introduction
The Rosemount™ TankMaster™ software is a powerful and easy-to-use Windows-based
software package that collects real-time data from level, temperature, density, and
pressure measurement instruments. This forms a key part of the Rosemount Tank
Gauging System. It gives organizations a complete overview of their full containment
storage tanks, leading to increased operational efficiency and safety. Further supporting
ease-of-use, TankMaster provides simple, step-by-step configuration and set-up guidance
for all measurement devices incorporated in the tank gauging system.

Rosemount TankMaster includes inventory management and rollover prediction, as well
as stratification monitoring and alarms, cool down and leak detection, and temperature
measurement overview. The software uses data from level, pressure, and product
temperature and density measurement devices to detect layering and calculate when a
rollover might occur.

By providing both inventory management and rollover prediction in a single software
solution, TankMaster reduces costs and increases ease-of-use.

Rosemount TankMaster is designed for use in monitoring applications and must not be a
part of a critical control and/or safety system. See Rosemount TankMaster End-User
License Agreement (EULA) for more information on terms and conditions.

Full support for non-homogeneous gases

TankMaster provides inventory management and rollover calculations to support safe
management of gases such as LNG:

• Support for configuration and operation of LTD devices

• Product temperature and density profile

• Product stratification monitoring and alarming

• On-line 24/7 product temperature profile as back-up to LTD-provided profile

• Rollover prediction
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1.2 Full containment system examples
Rosemount Tank Gauging supports full containment systems with various combinations
of field devices. This section illustrates the flexibility of system design with a couple of
examples.

System with radar level gauges

First example is a system with Rosemount 5900 Radar Level Gauges and various field
devices. The devices are connected to a Rosemount 2460 System Hub which sends
measurement data to the control room computers. The Rosemount Tank Gauging full
containment system supports up to four level gauges, 32 temperature elements for each
category of product temperature, leak detection temperature, and cool down
temperature measurements. The system also supports pressure measurements as well as
density and temperature profile scans.

Figure 1-1: Full Containment Tank System

A. Leak Detection Temperature - Rosemount 2240S Temperature Transmitter, Rosemount
2410 Tank Hub

B. Cool Down Temperature - Rosemount 2240S, Rosemount 2410
C. Primary Level - Rosemount 5900S Radar Level Gauge, Rosemount 2230 Field Display,

Rosemount 2240S, Rosemount 2410, Rosemount 2051 Pressure Transmitter
D. Secondary Level - Rosemount 5900S, Rosemount 2230, Rosemount 2410
E. Safety Level - Rosemount 5900S, Rosemount 2410
F. Level, Temperature, and Density device (LTD device)
G. Redundant Rosemount 2460 System Hubs
H. IEC 61508 SIL certified relay and/or 4-20mA
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Mixed system with radar and servo level gauges

Second example is a system with radar and servo level gauges and various field devices.
The devices are connected to a Rosemount 2460 System Hub which sends measurement
data to the control room computers.

Figure 1-2: Full Containment Tank System with Servo Gauges

A. Leak Detection Temperature - Rosemount 2240S Temperature Transmitter, Rosemount
2410 Tank Hub

B. Cool Down Temperature - Rosemount 2240S, Rosemount 2410
C. Primary Level - Rosemount 5900S Radar Level Gauge, Rosemount 2230 Field Display,

Rosemount 2240S, Rosemount 2410, Rosemount 2051 Pressure Transmitter
D. Secondary Level - Servo gauge
E. Safety Level - Servo gauge
F. Level, Temperature, and Density device (LTD device)
G. Redundant Rosemount 2460 System Hubs
H. IEC 61508 SIL certified relay and/or 4-20mA
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1.3 Technical documentation
The Rosemount™ Tank Gauging System includes a wide portfolio of user documentation.
For a complete list, see product pages on Emerson.com/Rosemount.

Reference manuals

• Rosemount Tank Gauging System Configuration Manual (00809-0300-5100)

• Rosemount 2460 System Hub (00809-0100-2460)

• Rosemount 2410 Tank Hub (00809-0100-2410)

• Rosemount 5900S Radar Level Gauge (00809-0100-5900)

• Rosemount 5900C Radar Level Gauge (00809-0100-5901)

• Rosemount 2240S Multi-Input Temperature Transmitter (00809-0100-2240)

• Rosemount 2230 Graphical Field Display (00809-0100-2230)

• Rosemount Tank Gauging Wireless System (00809-0100-5200)

• Rosemount TankMaster WinOpi (00809-0200-5110)

• Rosemount TankMaster Software Installation Manual (00809-0400-5110)

• Rosemount TankMaster WinSetup (00809-0100-5110)

• Rosemount TankMaster Network Configuration (303042EN)

• Rosemount 5900 Radar Level Gauge and Rosemount 2410 Tank Hub Safety Manual
Option S (00809-0400-5100)

• Rosemount TankMaster Mobile User Guide (00809-0100-5120)

• Rosemount TankMaster Mobile Installation Manual (00809-0200-5120)
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Product data sheets

• Rosemount Tank Gauging System (00813-0100-5100)

• Rosemount TankMaster Inventory Management Software (00813-0100-5110)

• Rosemount TankMaster Mobile Inventory Management Software (00813-0100-5120)

• Rosemount 2460 System Hub (00813-0100-2460)

• Rosemount 2410 Tank Hub (00813-0100-2410)

• Rosemount 5900S Radar Level Gauge (00813-0100-5900)

• Rosemount 5900C Radar Level Gauge (00813-0100-5901)

• Rosemount 2240S Multi-input Temperature Transmitter (00813-0100-2240)

• Rosemount 565/566/765/614 Temperature and Water Level Sensors
(00813-0100-5565)

• Rosemount 2230 Graphical Field Display (00813-0100-2230)
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1.4 Manual overview
This manual is a guide for using the Rosemount™ TankMaster™ software package for full
containment tanks. It is assumed that you have basic knowledge of setting up a
Rosemount Tank Gauging system. The purpose of this manual is to highlight specific
features and recommendations for using Rosemount TankMaster to install full
containment tanks.

Chapter Overview gives a brief introduction to the Rosemount™ TankMaster™ inventory
management software.

Chapter Getting started provides information on how to start using the TankMaster for a
full containment tank system.

Chapter Tank setup provides information on how to setup TankMaster for a full
containment tank system.

Chapter Product composition provides information on how to specify LNG compositions.

Chapter Rollover configuration provides information on tank and site setup for rollover
prediction.

Chapter Alarm setup shows how to setup various alarm limits as well as disconnecting
alarms.

Chapter Operation shows windows and functions for full containment tank monitoring in
Rosemount TankMaster WinOpi.

Overview Reference Manual
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2 Getting started
Prior to setting up a full containment tank in TankMaster, you need to ensure that all field
devices are properly installed and configured. Rosemount TankMaster WinSetup
configuration software is the recommended tool to setup a Rosemount Tank Gauging
system with field devices and various tank types.

2.1 Preparations
The following should be considered before a Full Containment system is installed and
configured using the Rosemount TankMaster Inventory Management software.

• Ensure that required license for Full Containment is enabled.

• Optional: if optional rollover prediction function is purchased, ensure that required
license for rollover prediction is enabled.

• Install and wire all field devices, such as Rosemount 2460 System Hubs, Rosemount
2410 Tank Hubs, Rosemount 5900 Radar Level Gauges, Rosemount 2240S Multi-Input
Temperature Transmitters, and LTDs.

• Verify device communication. Check for example the tank hub's Device Live List to
verify that all devices appear on the Tank Bus.

• Ensure that all information is available for temperature element positions in the tank.

• Ensure that a list with tag descriptions for all leak detection and cool down
temperature elements is available.

• Ensure that product composition data is available.

• Before closing the tank make sure to verify that still-pipes are in good condition. You
can use the Rosemount 5900's built-in Tank Scan function(1) to detect possible
disturbing irregularities inside the pipes.

Related information

System requirements
View hardware key options

(1) Tank Scan is available in TankMaster WinSetup via Rosemount 5900>Properties>Advanced window.

Reference Manual Getting started
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2.2 Recommended work flow
1. Install and wire all field devices.

2. Prepare a list of logical device names for all tank devices. This will make it easier
when all devices shall be associated with tank parameters in the tank installation
wizard.

3. In TankMaster WinSetup, install and configure devices using the device installation
wizard and specific configuration windows.

Note
Ensure that tank databases for Rosemount 2460 System Hubs and Rosemount 2410
Tank Hubs are properly configured. Note that devices that are connected to a tank
hub need to be configured in the tank databases of the tank hub as well as the
system hub. LTDs are connected directly to field ports on a Rosemount 2460
System Hub and need to be configured in the Rosemount 2460´s tank database
only.

Note
For some devices such as LTDs, the installation wizard does not include all
configuration options. If so, you may need to conduct further configuration in the
Properties window once the device is installed.

4. Configure the Rosemount 2410 Multiple Average Temperature (MAT) function if
needed. The MAT function allows you to exceed the maximum number of 16
temperature elements. You may use up to four Rosemount 2240S Temperature
Transmitters for the MAT function.

5. In TankMaster WinSetup, install and configure Full Containment tanks using the
tank installation wizard. This includes setting up associated devices for each tank
and configuring Leak and Cool Down temperature sensors.

6. In TankMaster WinOpi, configure the Product Table in case you will use LNG
composition data from this table:

a. Edit LNG compositions if needed. You may use this option in case you would
like to add new compositions, or update existing compositions.

b. Edit products; add products and select relevant data such as LNG
composition. Select volume table ISO6976 for LNG products.

7. Setup Tank Product Composition: select desired option for how to retrieve product
composition data.

8. In the Tank Capacity Setup window, configure the strapping table data, maximum
tank and outer vapor tank volumes.

9. In the Tank Volume Calculation Setup dialog, select desired product from the
Product Table. This step is required in case you will use composition data from the
Product Table. Also, select volume table ISO6976 for LNG products.

10. Setup Tank rollover parameters and data.

11. Setup Site rollover parameters and data.

Getting started Reference Manual
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2.3 System requirements
These are system requirements for using TankMaster with support for Full Containment
tank management. For complete system requirements see the Rosemount TankMaster
Software Installation manual and other technical documentation for Rosemount Tank
Gauging products.

Software

• Rosemount 2460: Firmware 1.J0 or later

• Firmware 1.K0 required for support of servo gauge Wärtsilä 1143

• TankMaster 6.G0 or later

Hardware

• USB port for TankMaster license hardware key

• USB port for rollover prediction license hardware key

Related information

Technical documentation

Reference Manual Getting started
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3 Communication setup
For optimum performance it is recommended that you configure a full containment
system for communication via Ethernet Modbus TCP.

Figure 3-1: TankMaster Communication with Field Devices and Host Systems

A

C

B

E

F
D

A. Host/DCS system
B. Modbus FCT Slave protocol via Ethernet/Modbus TCP
C. Rosemount TankMaster
D. Modbus Master protocol via Ethernet/Modbus TCP
E. Rosemount 2460 System hub
F. Rosemount 2410 Tank Hubs (connected to field devices)
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3.1 Master protocol server configuration for
Modbus TCP
This description shows how to setup the Modbus Master protocol for Ethernet/TCP
communication. It allows optimum performance for TankMaster communication with
Rosemount 2460 System Hubs.

Procedure

1. Make sure that WinSetup is up and running.

2. Open the Protocols folder.

3. Right-click ModbusMaster and select Properties.

4. Select the desired protocol channel (MbMaster.1 for example) and select the
Properties button.

Communication setup Reference Manual
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5. Select Enable Channel.

6. Select Modbus TCP (Ethernet).

7. Enter desired IP address.

8. Optional: Port number 502 is default and does normally not need to be changed.

9. Select Apply to save the configuration.

10. Select OK to finish and close the window.

Postrequisites

In the WinSetup workspace you may verify that the Modbus TCP protocol channel is
enabled:

Reference Manual Communication setup
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3.2 Slave protocol server configuration for Modbus
TCP
This description shows how to setup the Modbus TCP slave protocol for full containment
tank systems in TankMaster WinSetup. This protocol should be used for communication
between host/DCS systems and TankMaster servers.

Procedure

1. Make sure that WinSetup is up and running.

2. Open the Protocols folder.

3. Right-click ModbusFCTSlave and select Properties.

4. Select the desired protocol channel (MbFCTSlave.1 for example) and select the
Properties button.

Communication setup Reference Manual
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5. Select Enable Channel.

6. Select Modbus TCP (Ethernet).

7. Optional: Port number 502 is default and does normally not need to be changed.

8. Enter desired Address.

Description is optional.

9. Select the Tank Mapping tab:
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10. Use the arrow button to move the desired full containment tanks from Available
Tanks to Mapped Tanks in order to allow communication with a host server.

11. Select Apply to save the configuration.

12. Select OK to finish and close the window.

Postrequisites

In the WinSetup workspace you may verify that the Modbus TCP protocol channel is
enabled:
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4 Device setup

4.1 Using the installation wizard
The device installation wizard guides you step-by-step through the installation procedure.
The wizard supports installation of multiple device types such as the Rosemount 2460
System Hub, Rosemount 2410 Tank Hub, Rosemount 5900 Radar Level Gauge,
Rosemount 2240S Multi-Input Temperature Transmitter as well as various types of LTDs.
TankMaster also supports installation of level devices such as the Wärtsilä 1143 servo
gauge.

Procedure

1. Ensure that TankMaster WinSetup is up and running.

2. On the Devices folder, click the right mouse button and select Install New from the
pop-up menu, or from the Service>Devices menu select Install New.

3. Follow the instructions in the device installation wizard.
Once a device is installed, it appears in WinSetup's tree structure under the current
tank as well as under the Devices folder.
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4.2 Rosemount 2460 tank database configuration
It is important that the tank database is properly setup for proper communication with
field devices.

The Rosemount 2460 System Hub collects measurement data from one or multiple tanks.

For standard configurations, each position in the system hub's tank database represents
one tank. For LNG Full Containment tanks, it is common that the tanks are equipped with
multiple tank hubs, level devices, and temperature transmitters as well as other
measurement instruments. As a result the tank database must be configured accordingly.
The purpose of the following example is to show a tank database configuration for a Full
Containment tank equipped with multiple instruments. Although the instrument setup
may differ between different tanks, the general principles of tank database configuration
apply.

This example is based on a Rosemount 2460 tank database configuration for a full
containment tank with the following device setup:

Table 4-1: Device Setup Example

Item Devices

Primary level and product
temperature

• Rosemount 2410 Tank Hub

• Rosemount 5900 Radar Level Gauge

• 2 x Rosemount 2240S Temperature transmitter

• Rosemount 2230 Graphical Field Display

• Rosemount 2051 Pressure Transmitter(1)

Secondary level • Rosemount 2410 Tank Hub

• Rosemount 5900 Radar Level Gauge

• Rosemount 2230 Graphical Field Display

Safety level • Rosemount 2410 Tank Hub

• Rosemount 5900 Radar Level Gauge

Leak detection temperature • Rosemount 2410 Tank Hub (Leak detection and Cool down)

• 2 x Rosemount 2240S Temperature transmitter

Cool down temperature • Rosemount 2410 Tank Hub (Leak and Cool down)

• 2 x Rosemount 2240S Temperature transmitter

Product Density and
Temperature profiles

• LTD (W-1146/SI-6290/SI-7000)

(1) Required for rollover prediction.
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Figure 4-1: Tank Database in Rosemount 2460
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The tank database example is based on a tank equipped with multiple instruments as
illustrated below.

Figure 4-2: Full Containment Tank with Multiple Instruments

A. Leak Detection Temperature
B. Cool Down Temperature
C. Primary Level
D. Secondary Level
E. Safety Level
F. Level, Temperature, and Density device (LTD device)
G. Redundant Rosemount 2460 System Hubs
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4.3 Configuring the Rosemount 2410 Multi
Average Temperature function
The Rosemount Tank Gauging system is designed for using up to 16 spot or average
temperature sensors. Full containment tank applications may require more temperature
sensors for temperature profiling. The Rosemount 2410 supports up to four Rosemount
2240S temperature transmitters when using the Multi Input Average Temperature
function. Typically two temperature transmitters will be connected that occupy Tank
Position 1 and Tank Position 2.

The Multi Average Temperature function is available in the tank hub's
Properties>Advanced Configuration tab.

Figure 4-3: Rosemount 2410 Advanced Configuration Window

Select Multi Avg Temp Function to open the configuration view. In this example there are
two temperature transmitters connected to the Rosemount 2410 Tank Hub. The
transmitters are configured in tank position 1 and 2, respectively. In case you have three or
four temperature transmitters connected to the tank hub, the corresponding check boxes
would be enabled.
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Tank Pos 1 is automatically selected for the temperature transmitter that is configured in
position 1 of the tank hub's database.

In case there are two temperature transmitters, you need to select the check box for Tank
Pos 2 as well to make sure that the second transmitter is included in the average product
temperature calculations.

Figure 4-4: Rosemount 2410 Multi Average Temperature

Related information

Temperature element configuration
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4.4 Temperature element configuration
It is important that temperature element positions are properly configured in order to
ensure correct Average Temperature calculations. This example shows how to configure
temperature element positions for the Rosemount 2240S transmitter when using two
transmitters for a total of 32 elements.

Tank configuration includes mapping of temperature transmitter output to tank
temperature input. The TankMaster WinSetup configuration tool allows you to select
element mapping based on sequential or ZigZag/Parallell mapping as illustrated in Figure
4-6 and Figure 4-7.

The Rosemount 2240S has 16 temperature element positions. Elements must always be
numbered in the order from bottom of the tank to the top.

When multiple Rosemount 2240S transmitters are used in combination with the
Rosemount 2410's Multi Average Temperature function, the temperature transmitter in
tank database position 1 must be the transmitter that has its first element closest to the
bottom of the tank. Make sure that the temperature elements are placed in the order that
supports the desired tank temperature element configuration.

Description text field is optional information. It will be informative for Leak and Cool Down
temperature elements when these appear in WinOpi views.

Figure 4-5: Average Temperature Calculation Configuration
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Tank Temperature Configuration

Figure 4-6: Sequential Temperature Element Configuration
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Figure 4-7: ZigZag Temperature Element Configuration
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Related information

Configuring the Rosemount 2410 Multi Average Temperature function
Tank configuration
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4.5 LTD installation and configuration
Supported LTD devices are installed and configured by using Rosemount TankMaster
WinSetup configuration software. Once installed and configured, TankMaster reads
measurement data from LTD devices for temperature and density monitoring.

4.5.1 Configure LTD in Rosemount 2460 Tank Database
Prior to installing a LTD device in TankMaster you need to make sure that it is configured in
the Rosemount 2460 tank database.

Open TankMaster WinSetup, right click the appropriate Rosemount 2460 and select
Properties. Select the Tank Database tab. You need to configure the following:

• Port number of the Rosemount 2460 field port that the LTD is wired to.

• Level Device Address. It is recommended to use a free address in the range 1 to 99.

• Observed Density (DOBS). If this field is left blank the system hub will not poll density
values from the LTD.

• Advanced settings such as LTD profile area number and Average Product Temperature.

Figure 4-8: Rosemount 2460 Tank Database

4.5.2 Install a new LTD
This section describes how to install an LTD in Rosemount TankMaster WinSetup.

Prerequisites

Make sure that the LTD device is properly wired to a Rosemount 2460 System Hub field
port. Prior to installing the LTD, ensure that it is configured in the system hub's tank
database. Make a note which tank position that is used for the LTD. Also, ensure that you
know the system hub's tag name so you can select the correct system hub when installing
the LTD.

Procedure

1. Make sure that the TankMaster WinSetup configuration program is up and running.

2. In the WinSetup workspace, click the right mouse button on the Devices folder.

3. Select Install New.

4. From the Device Type drop-down list, select the appropriate LTD type.

5. Ensure that correct system hub is selected in the drop-down list.
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6. Enter Tank position in 2460 and select Verify Communication.
A message appears that the LTD was successfully found.

Need help?
If the LTD was not found:
• verify that the correct system hub is selected

• check the system hubs tank database for the correct tank position

7. Click Next and verify that correct information is presented in the Summary window.

8. Click Finish and verify that the device appears in the WinSetup workspace under the
appropriate Rosemount 2460 System Hub.

Postrequisites

Once the LTD is successfully installed, proceed with configuring the device.

4.5.3 Configure an LTD
This is a description on how to configure an LTD device in TankMaster WinSetup.

Prerequisites

Ensure that the device is up and running and is installed in TankMaster WinSetup.

Procedure

1. Make sure that the TankMaster WinSetup configuration program is running.
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2. In the WinSetup workspace, click the right mouse button on the desired LTD device
and select Properties:

The Configuration window appears. It has a number of tabs depending on LTD type.

3. Perform the required configuration and select Apply to save the configuration.
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4.5.4 LTD W-1146 configuration
This section describes supported device configuration options, and tape and profile
configuration options for a W-1146 LTD.

Table 4-2: W-1146 Configuration Options

Option Description

Sensor Calibration Constants These constants are provided with a calibration certificate that is
unique for the specific sensor head

Surface Interface Surface Interface parameters are required for the device to be
able to find the liquid surface. The interface density value shall be
set to a value at 85% of the product density.

Parameter Offsets These offsets are used to adjust the densitometer values for level,
temperature and density.

Safety Internal safety alarm limits for the LTD device. The reed switch
alarm can be enabled or disabled, software high and low limits
can be configured. These alarm statuses can be monitored by
external host systems via Gauge Status register in the LTD
device.

Sensor Motor Allows you to select Normal or Low speed.

Table 4-3: W-1146 Tape and Profile Configuration Options

Option Description

Tape and Contraction
Compensation

• Tank height, LTD R distance

• Tank inner roof position, distance from bottom of tank to
inner roof

• Upper vapor temperature, the normal temperature in the
upper vapor space above the inner roof

• Vapor temperature, the normal vapor temperature below the
inner roof

• Temperature contraction factor, fixed calibration value for
the tape

• Enable or disable the tape contraction compensation
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Table 4-3: W-1146 Tape and Profile Configuration Options (continued)

Option Description

Profile Configuration The customized profile will be used in the 2460 automatic
scheduling function:
• Profile start position, normally the profile starts 1 meter

above the bottom.

• Profile end position, approximately 1 meter below normal
max operation level for the tank.

• Recommended profile sample interval is 0.5 meter. If
maximum product level is above 50 meter, set the interval to
1 m or 0.6 m to cover the level measuring range.

Note
In order to ensure reliable layer height calculations it is not
recommended to use intervals less than 0.4 m.

• Surface canceling distance. If the last sample is between the
Product Level and (Product Level – Canceling Distance) the
last sample will not be used.

Automatic Profile
Configuration

The Rosemount 2460 will send customized profile commands to
all installed LTD W-1146 devices according to the configured
scheduling:
• Use configured start time and interval; first profile starts at

the configured time (recommended option)

• Use configured start time and 24 hours interval; all profile
starts at the configured time with 24 hours interval

• Automatic Profile function is disabled
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4.5.5 LTD SI-6290/7000 configuration options
This section describes supported device configuration options, and tape and profile
configuration options for a SI-6290/7000 LTD.

Table 4-4: SI-6290/7000 Profile Configuration Options

Option Description

Start Position Typically the profile starts 1.0 meter above the bottom.

Sample Interval Recommended profile sample interval is 0.5 meter. If maximum
product level is above 50 meter, set the interval to 1 m or 0.6 m
to cover the level measuring range.

Note
In order to ensure reliable layer height calculations it is not
recommended to use intervals less than 0.4 m.

Dwell Time Time in seconds that the probe will pause at each point to allow
readings to stabilize before reading the value.

Table 4-5: SI-6290/7000 Automatic Profile Scheduling

Option Description

Enable or disable automatic
profiles

The following alternatives are available:
• Use configured start time and interval. First profile starts at

the configured time. (recommended option)

• Automatic Profile function is disabled.

Start Hour The hour when profiling will start

Start Minute The minute when profiling will start

Interval time Time in minutes between automatic profiles

Table 4-6: SI-6290/7000 Alarms

Option Description

Level Alarm Set Points
Internal alarm limits in the LTD. These alarms can be monitored
by external host systems via Alarm Status registers in the LTD
device, or specific 2460 Input registers in selected Profile Area.

Temperature Alarm Set Points

Density Alarm Set Points
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5 Tank setup

5.1 System setup
The System Setup window lets you configure system settings for inventory management.
Specific settings for LNG applications are also included.

Important
Standard system and calorific units must be configured prior to tank installation.

Figure 5-1: System Setup

LNG Reference conditions

The ISO6976 standard is used for Full Containment tanks and specifies methods for
calculation of gross calorific value, density, and Wobbe index of natural gases. Reference
conditions can be changed and will be used for tanks using table ISO6976 for calculations
of gross calorific value, Wobbe index, and reference density.

LNG Methane Number ISOTR22302 Calculation Mode

Methane Number is calculated according to one of the following two methods:

• according to Hydrogen/Carbon ratio relation

• according to Linear coefficient relation

Presentation accuracy for Density and Temperature

You may configure TankMaster to present density and temperature with an extra decimal
compared to the default setting. In case measurement values with higher accuracy are not
available, the extra decimal is set to zero.
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5.2 Tank installation
This section describes how to install and configure Full Containment tanks in Rosemount™

TankMaster WinSetup.

5.2.1 Tank installation procedure
This is a guide how to use the TankMaster WinSetup installation wizard for installing Full
Containment tanks.

The TankMaster installation wizard includes the most important steps for installing and
configuring a tank. Further configuration can be made at any time by selecting Properties
for the desired tank.

Prerequisites

Make sure that all devices to be associated with the tank are installed in TankMaster
WinSetup.

Note
Full containment tank installation requires hardware key with appropriate license options.

Procedure

1. In TankMaster WinSetup, click the right mouse button on the Tanks folder and select
Install New.
The tank installation wizard opens.

2. Select tank type Full Containment and enter the desired Tank Tag. Tank type Full
Containment is automatically selected in case you click the right mouse button on
an existing Full Containment folder instead of the Tanks or All Tanks folder. Click
Next to continue.

In case you click the right mouse button on an existing Full Containment folder,
tank type Full Containment is automatically selected.
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3. Select all devices to be associated with the tank. Use the arrow button to move
devices from Available Devices to Selected Devices. When finished, click Next to
continue.

4. Verify that all level and temperature parameters are connected to the appropriate
devices. See Tank configuration for more information. Click Next to continue.
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5. Verify that Value Source is set to Automatic. However, the Value Entry window can
be used to configure manual values for service purposes. Manual values are marked
yellow in order to distinguish them from automatic measurements. Make sure that
Maximum values are configured for all level parameters such as Level, Secondary
Level, Overfill Level, Third Level, and LTD Level. Click Next to continue.

6. Verify that Tank tag is correct, and Devices include all devices that are required for
the tank. If any changes are needed, you may click the Back button and return to
the desired window. Otherwise click the Finish button to save the tank installation
and exit.

7. In WinSetup and WinOpi verify that measurement data appears as expected.

Once the installation wizard is finished you may modify the current tank
configuration at any time.
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The tank appears in the WinSetup workspace.

Figure 5-2: Full Containment Tank in WinSetup

Postrequisites

Use TankMaster WinOpi operator's interface for setting up the tank for full containment
tank inventory management.

Related information

Tank configuration
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5.3 Tank configuration
Tank configuration allows you to associate devices as source input to various tank
variables.

The Tank Configuration window provides options for mapping of:

• product level (Primary, Secondary, Overfill, LTD)

• product temperature

• outer vapor temperature

• vapor temperature

• vapor pressure

• leak detection temperature

• cool down temperature

To open the Tank Configuration window:

1. In the WinSetup workspace click the right mouse button on the tank.

2. Select Properties.

3. In the Properties window select the Configuration tab.

Figure 5-3: Tank Configuration

Level source

Level sources includes level devices for Primary, Secondary, Overfill, and LTD. You can
choose input from associated devices in the left-hand side of the Tank Configuration
window. Missing devices can be added by clicking the Change button to open the Select
Devices window.

Note
Only one LTD can be selected for the tank. In case you need to change tank input to
another LTD (advanced configuration), all inputs must be change to the same LTD.
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Product temperature configuration

The ATD device (temperature and other non-level devices) selected as Product Temp
Device 1 is used as default source for Average Product Temperature.

The Temp Configuration drop-down menu includes schemes for mapping of product
temperature device outputs to tank temperature inputs. Available options are:

• Zigzag / Parallel Temperature Configuration. First tank element will use first element
from the Device 1, second tank element will use first element from the Device 2, etc.
This is the default option.

• Sequential Temperature Configuration. The first 16 tank elements are mapped from
Device 1, then the following 16 elements from Device 2 (17 – 32) .

• Custom (advanced configuration). This option requires advanced tank configuration to
map product temperature elements. You may use any number of ATDs for arbitrary
output mapping.

Vapor source

The ATD device (temperature, vapor) selected as Product Temp Device 1 is used as
default source for Vapor Temperature and Vapor Pressure. Select the desired inputs for:

1. Outer Vapor Temperature. The drop-down list presents all available temperature
elements. Select a temperature element that is suitable for the current tank. Note
that numbering starts with the element at the bottom of the tank.

2. Vapor Temperature. From the drop-down list, select the standard Vapor
Temperature (VT) parameter. This is the average temperature of all elements
above the product surface. If needed, you may select a specific temperature
element instead.

3. Vapor Pressure. Select the desired pressure source and measurement unit. Ensure
that the Rosemount 2460's tank database Auxiliary Inputs block is configured for
Vapor Pressure (VP) so that it properly polls pressure values.

Leak detection temperature

The Leak Temperature Configuration button opens a view that lets you map tank leak
detection temperature elements (1 – 32) to device output.

Cool down temperature

The Cool Down Temp Configuration button opens a view that lets you map cool down
temperature elements (1 – 32) to device output.

Advanced configuration

The Advanced Configuration button opens a view that allows you to setup tank inputs not
included in a standard configuration.

Note
This options allows you to map tank inputs to device outputs for advanced tank setup. It
should only be used by personnel with proper skills and experience.
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Level rate

When connected to a level gauge, such as the Rosemount 5900S, TankMaster uses the
Level Rate value that is calculated by the level gauge. For devices without internal
calculation of Level Rate, it can be calculated by TankMaster instead.

Related information

Tank installation procedure
Leak detection temperature configuration
Cool down temperature configuration
Advanced configuration
Temperature element configuration
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5.3.1 Leak detection temperature configuration

Tank Leak Temperature Configuration window is specific for Full Containment tank type
and is used to map tank leak detection temperature elements (1 – 32) to device output.

For each temperature element you can:

• select a device source (device name)

• select a temperature element (TT[x]).

Leak detection temperature elements without configured source (set as “<none>”) will
not appear in TankMaster WinOpi.

The Select Devices button opens a window where you can limit the number of devices in
the device sources combo boxes. This may be useful in case of large number of installed
ATD devices.

Unique tags can be specified in the Average Temperature Calculation window for the
associated temperature transmitter (ATD). The Description field lets you enter a tag which
will appear in the Tank Leak Temperature Configuration window. See Tags for temperature
elements for more information.

Figure 5-4: Tank Leak Temperature Configuration
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5.3.2 Cool down temperature configuration

The Cool Down Temperature Configuration window lets you map tank cool down
temperature elements (1 – 32) to device output.

For each temperature element you can:

• select a device source (device name)

• temperature element (TT[x]).

Cool down temperature elements without configured source (“<none>”) will not appear in
WinOpi.

The Select Devices button opens a window where you can limit the number of devices in
the device sources combo boxes. This may be useful in case of a large number of installed
ATD devices.

Unique tags can be specified in the Average Temperature Calculation window for the
associated temperature transmitter (ATD). The Description field lets you enter a tag which
will appear in the Cool Down Temperature Configuration window. See Tags for temperature
elements for more information.

Figure 5-5: Tank Cool Down Temperature Configuration

Tank setup Reference Manual
June 2021 00809-0500-5110

46 Emerson.com/Rosemount



5.3.3 Tags for temperature elements
This is a description of how to add tags for temperature elements in Tank Leak Detection
Temperature and Tank Cool Down Temperature configuration windows.

Prerequisites

Make sure that Rosemount TankMaster WinSetup configuration software is up and
running.

Procedure

1. In the WinSetup workspace, expand the desired full containment tank icon and
associated device icons.

2. Right-click the ATD(2) device icon and select Properties.

(2) ATD includes temperature transmitters and other non-level devices.
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3. Open the Average Temperature Calculation tab.

4. Enter the desired tags in the Description fields.

Text entered in the description fields will appear as tags for temperature elements
in the Tank Leak Temperature Configuration and Tank Cool Down Temperature
Configuration windows.

You can edit fields for as many temperature elements as specified in the No of
Elements drop-down list in the left-hand side of the window.

5. Click OK to save the configuration and close the window.
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5.3.4 Advanced configuration

The Advanced Tank Setup window lets you map tank parameters to device output. You may
for example setup tank inputs that are not included in a standard configuration.

This option should only be used for advanced configuration in case the standard setup is
not sufficient.

Figure 5-6: Advanced Configuration
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6 Tank product composition setup

For a full containment tank you can use product composition data from:

• Product table

• Manually entered data

• Calculated product composition

In case you use composition data from the Product Table, you need to specify which
product to use and ensure that product data is properly setup.

6.1 Tank product composition setup using product
table
In case you will use composition data from the Product Table, you need to setup desired
products and specify which product to use.

The basic steps for product composition setup using Product Table:

1. Add required product to the Product Table.

2. Select desired LNG Composition for the product. You may add new product
compositions if needed.

3. Configure Tank Volume Calculation with the desired product for the tank.

4. Configure the tank to use product composition from the Product Table.

Prerequisites

Make sure that the required product compositions are included in the LNG Compositions
table. See section Product composition.
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Procedure

1. Start TankMaster WinOpi and open the Product Table.

Menu: Setup>Product table.

2. Select an empty row and select Edit Product.

3. Specify required product data and select the desired LNG Composition from the
drop-down list. Click OK to close and save the product configuration.
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4. Open the Tank Volume Calculation window, and select desired product for the tank.

Menu: Setup > Tank Setup > Tank Volume Calculation.

5. In WinOpi, select the tank and open Setup → Tank Setup → Tank Product
Composition Setup.
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6. In the Tank Product Composition Setup window, select Use composition data from
Product Table.

7. Select OK to save the setup and close the window.

Postrequisites

In the Tank Stratification window check that correct product composition appears.
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6.2 Tank product composition setup using manual
or calculated data
This is a description of how to configure a tank for manual or calculated composition data.

Procedure

1. Make sure that TankMaster WinOpi is up and running.

2. In WinOpi, select the tank and open Setup → Tank Setup → Tank Product
Composition Setup.

3. In the Tank Product Composition Setup window, select the desired option:
• Use manually entered composition data

• Use calculated composition data

For manual composition data proceed with editing the composition table.

4. Enter composition data for the desired items in the appropriate entry fields.
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5. When the table is finished, verify that total sum equals 100%.

6. Select Apply/OK to save the composition and close the window.

Postrequisites

Open the Tank Stratification window and verify selected product compositions.
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7 Product composition

7.1 Product composition setup
The LNG Composition window allows you to specify the exact composition of LNG
products. From this table you can select appropriate location for LNG products which are
added to the Product Table.

Figure 7-1: LNG Compositions Window

The system supports a product library with standard LNG compositions. There are various
LNG export sites available that you can select for a full containment tank. The selected LNG
composition is used as initial composition for the tank.

It is possible to edit the LNG composition of an existing location, or add a new location.
The LNG Compositions window can be opened from the Product Table window via the Edit
LNG Compositions button. This function is enabled if the appropriate TankMaster license
option is enabled in the hardware key.

The LNG Compositions window represents a table which is initially filled with a large
number of existing locations(3). Each location is characterized with its unique composition
of natural gases that the location provides.

(3) Product compositions delivered by the export sites year 2012.
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7.1.1 To open the LNG Compositions window
Procedure

1. Ensure that TankMaster WinOpi is up and running.

2. In the WinOpi workspace, select menu option Setup → Product Table.

3. In the Product Table window, select the Edit LNG Compositions button.
The LNG Compositions window appears.
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7.2 Edit LNG composition
Procedure

1. In the LNG Compositions window do one of the following:
• select an empty table cell in case you would like ta add a new composition

• select a table cell for the desired location in case you would like to edit an
existing composition

2. Click the Edit Composition button.

3. In the Edit LNG Composition window enter the desired ratio for each component that
should be included in the composition.

4. When the table is finished, verify that total sum equals 100%.
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5. Select OK to save the composition and close the window.
A warning appears in case the total sum deviates from 100%. In case of a minor
deviation from 100% you will still be able to save the composition.
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8 Rollover configuration
Rollover data can be setup for individual tanks and for a site in order to enable rollover
calculations.

Rollover calculation requires license option LNG/Full Containment Tank Management +
Rollover prediction.

8.1 Rollover prediction calculations
Rosemount TankMaster supports LNG Full Containment tank management and rollover
prediction calculations.

Required inputs for rollover prediction calculations:

• Rollover site setup

• Site operating pressure (based on tank pressure input)

• Tank rollover configuration

• Tank observed volume

• Tank stratification status

• Tank profile layer data:
— Height

— Average layer temperature

— Average layer density

— Product composition for layers

• Tank flow rate for the LNG send out

Input values for product composition:

• Average layer temperature (from tank temperature profile)

• Average layer density (from tank density profile)

• Vapor pressure
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8.2 Rollover tank setup
This section describes setup of tank rollover parameters and data.

Tank Data

Figure 8-1: Tank Rollover Setup Window

Table 8-1: Tank Data Configuration Parameters

Parameter Description

Inner Diameter Inner diameter of the tank. The value is entered in tank level unit.

Inner Wall Height Maximum filling height of the tank. The value is entered in tank
level unit.

Inner Wall Emissivity The emissivity of the tank wall surface. It defines its effectiveness
in emitting energy as thermal radiation. The value has no unit
and shall be in the range 0 – 1 (a polished blank surface is close to
0) .

Inner Roof Emissivity The emissivity of the tank roof surface.

Average LNG send out LNG send out from the tank to production of gas. The value is
entered in tank flow rate unit.

Gas phase Wall heat leak Heat leaks which are transmitted to the gas phase by the tank
walls. Heat leaks can be estimated using the characteristics of the
tank wall conductivity, its thickness and the temperature
difference between the outside and the LNG product inside the
tank. The value is entered in W/m2.

Gas phase Roof heat leak Heat leaks which are transmitted to the gas phase by the tank
roof.
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Table 8-1: Tank Data Configuration Parameters (continued)

Parameter Description

LNG phase Wall heat leak Heat leaks which are transmitted to the LNG phase by the tank
walls.

LNG phase Bottom heat leak Heat leaks which are transmitted to the LNG phase by the tank
bottom.

Safety Devices

Table 8-2: Safety Device Parameters

Parameter Description

Type Type of safety device: Valve, Rapture disk, Vent.

Opening Pressure Opening pressure for the safety device. The value is entered in
tank pressure unit.

Max Flow Rate Maximum gas flow rate which the safety device can handle. The
value is entered in tank flow rate unit.

8.2.1 To open the Rollover Tank Setup window
To open the Rollover Tank Setup window:

Procedure

1. Ensure that TankMaster WinOpi is up and running.

2. In the workspace window, select the desired full containment tank.

3. Do one of the following:

• Select menu option Setup → Tank Setup → Tank Rollover Setup

• Righ-click the Full Containment tank icon and select Tank Setup → Tank
Rollover Setup
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8.3 Rollover site setup
This section describes setup of tank site parameters and data.

Site Data

Figure 8-2: Rollover Site Setup

Table 8-3: Site Data Configuration Parameters

Parameter Description

Barometric Pressure The average local air pressure, this value depends on weather
conditions and geographical position. The value is entered as
absolute pressure in system pressure unit.

Total Site Volume This is the total LNG site volume, all LNG tanks connected to each
other and BOG pipe collectors. The value is entered in system
volume unit.

Max BOG Flow Rate Total maximum gas flow rate which the site’s Boil off Gas (BOG)
compressor(s) can handle. The value is entered in system flow
rate unit.

Safety Devices

Table 8-4: Safety Device Parameters

Parameter Description

Type Type of safety device: Flare (handles the BOG that the
compressor(s) cannot handle).

Opening Pressure Opening pressure for the safety device. The value is entered in
system pressure unit.

Max Flow Rate Maximum gas flow rate which the safety device can handle. The
value is entered in system flow rate unit.
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8.3.1 To open the Rollover Site Setup window
To open the Rollover Site Setup window:

Procedure

1. Ensure that TankMaster WinOpi is up and running.

2. Select menu option Setup → Rollover Configuration.
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9 Alarm setup
For a full containment tank you can set alarm limits and deviations in a dedicated window
accessed from the standard Alarm Limits window.

Related information

View alarms

9.1 Full containment alarm limits
The Full Containment Alarm Limits window lets you configure deviation alarms and rollover
prediction alarms. For product temperature, deviations are monitored between
subsequent temperature elements as well as between individual temperature elements
and average product temperature.

Level deviations are monitored between Primary level device and additional level devices,
such as Secondary and Overfill depending on which devices you select to include in the
deviation check.

Figure 9-1: Full Containment Alarm Limits Window

You may configure the following deviations and alarm limits:

• Level Deviation - Hi and HiHi limits, Hysteresis and Delay

• Product Temperature Deviation - Hi and HiHi limits, Hysteresis and Delay

• Profile Density Deviation - Hi and HiHi limits, Hysteresis and Delay

• Profile Temperature Deviation - Hi and HiHi limits, Hysteresis and Delay

• Leak Detection Temperature – Lo limit, Hysteresis and Delay

For rollover prediction calculations you may configure the following alarm limits:
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• Number of days to rollover - Lo, LoLo, Hysteresis and Delay

• Maximum Boil Over Gas (BOG) - Hi, Hysteresis and Delay

• Maximum Gas Pressure - Hi, Hysteresis and Delay

The check box named Use the same leak low alarm limits for all elements lets you set
the same Lo limit, Hysteresis and Delay for all Leak Temperature elements.

If each element needs to be configured individually, the check box must be unselected.
Then, after pressing the >> button a table appears which allows you to set limits separately
for each element.

Figure 9-2: Full Containment Alarm Limits Extended Window

If Use the same leak low alarm limits for all elements is selected, the table will be
presented for view only. As a result it will not be possible to edit any table data.

9.1.1 To open Full Containment Alarm Limits
Procedure

1. Ensure that TankMaster WinOpi is up and running.

2. In the WinOpi workspace do one of the following:
• right-click the full containment tank icon and select Alarm Entry → Alarm

Limits

• open menu Entry → Alarm Entry → Alarm Limits.

3. In the Alarm Limits window select the Full Containment Alarm Limits button.
The Full Containment Alarm Limits window appears.
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9.2 Alarm disconnect
Alarm disconnect has extended functionality for Full Containment tanks.

Alarm disconnect options for Full Containment tanks are available if the hardware key has
at least one Full Containment option enabled.

For Full Containment tanks several options are available in addition to the standard alarm
disconnect options:

• Auxiliary Level Alarms
— Secondary Level

— Overfill Level

— Third Level

— LTD

• Deviations
— Level Deviation

— Temperature Deviation

• Profile deviations
— Temperature Deviation

— Density Deviation

— Sample Temperature Deviation

— Sample Density Deviation

• Rollover and Stratification
— Number of Days to Rollover

— Maximum BOG

— Maximum Gas Pressure

• Product temperature for up to 32 elements

• Leak detection temperature for up to 32 elements

• Cool down temperature for up to 32 elements
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Figure 9-3: Alarm Disconnect Window

The Disconnect Tank check box disconnects all alarms. This will be indicated by a special
tank icon in the TankMaster WinOpi workspace:

Figure 9-4: All Alarms Disconnected for a Tank

9.2.1 To open the Alarm Disconnect window
To open the Alarm Disconnect window:

Procedure

1. Ensure that TankMaster WinOpi is up and running.

2. Right-click the desired tank.

3. Select Alarm Entry → Alarm Disconnect .
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10 Operation
This section shows the available windows and functions for full containment tank
monitoring in Rosemount TankMaster WinOpi.

10.1 Workspace
When a full containment tank is installed in Rosemount TankMaster, it appears in the All
Tanks group as any other tank. You can create a custom tank group and move full
containment tanks to that group. Full Containment tanks appear with a unique icon to
distinguish them from other tank types.

Figure 10-1: Workspace in TankMaster WinSetup and WinOpi
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10.2 Menus
Full Containment tanks have their own pop-up menu, called View Full Containment Tank,
accessible both from the main application menu and by mouse right-click.

Figure 10-2: Full Containment Tank Menus
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10.3 Tank parameter overview
The Overview window shows full containment tank parameters as well as alarm status.

Figure 10-3: Tank Overview

Up to four level bar graphs for Primary, Secondary, Overfill, and LTD levels can be shown.
The specific bar graphs appear only if corresponding levels are configured in the Tank
Configuration window or in the Advanced Configuration window.

Related information

Tank configuration

10.3.1 How to open Tank Overview
Procedure

1. Ensure that TankMaster WinOpi is up and running.

2. In the WinOpi workspace do one of the following:
• right-click the full containment tank icon and select View Full Containment

Tank  → Overview

• open menu View → Full Containment Tank  → Overview.

The Tank Overview window appears.
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10.4 Tank stratification
This section provides information on data presented in the Tank Stratification window.

This window presents current stratification in a full containment tank. It is possible to
configure colors for Lower, Intermediate, and Upper Product layers.

Figure 10-4: Tank Stratification Window

The following information is presented:

• Current stratification status such as Alarm etc.

• Upper product layer information.

• Intermediate product layer information.

• Lower product layer information

• Product Molar composition in a separate table
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10.5 Tank rollover prediction
This section provides information on data presented in the Tank Rollover window.

The Tank Rollover window presents predicted rollover data and data for upper,
intermediate, and lower product layers for a full containment tank.

In addition to that, predicted product molar composition is presented in a table for the
upper and lower product layers.

Figure 10-5: Tank Rollover Window

Prediction data presented:

• Rollover status

• Calculation date

• Rollover date

• Maximum BOG peak

• Maximum pressure peak

• Layer temperature

• Layer Gross Calorific Values

• Layer molar composition (in separate table)

Product colors for bottom, intermediate, and top layers can be configured.

Rollover prediction status

The following status options are available:
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• No rollover predicted

• Rollover prediction available

• Rollover prediction warning

• Rollover prediction alarm

Rollover site setup data

The following input data must be available for the rollover prediction calculations:

• Barometric pressure

• Total site volume

• Maximum BOG Flow Rate

• Safety devices:
— Type of safety device

— Opening pressure for the safety device

— Maximum flow rate that the safety device can handle

Related information

Rollover tank setup
Rollover prediction status view
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10.5.1 Rollover prediction status view
The Rollover Prediction window shows current prediction status.

Table 10-1: Rollover Prediction Status

Status View

No prediction available

Prediction available

Warning

Alarm
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10.6 Product profile
The Product Profile window shows profile data for product Density and Temperature. Data
is presented both in table view and graphs. Active alarms are indicated with red circles.

Figure 10-6: Product Profile

A. Select profile
B. Show alarms in graphs check box
C. Select History Data button
D. History Table View button
E. Show history check box
F. Reports (PDF, CSV)

Related information

Alarm setup
View alarms
Historical data
Alarm and zooming
Reports
Select historical data profiles

Operation Reference Manual
June 2021 00809-0500-5110

78 Emerson.com/Rosemount



10.6.1 Historical data
Note
You need to setup Historical Data Log in order to enable profile historical data.

To enable viewing historical data you need to select historical data profiles in the Select
History Data window. These profiles will then be available for viewing in the Product Profile
window.

If historical data is enabled a list of historical profiles is added on the right-hand side. From
the list you can select profile data that you want to include in the Density and Temperature
profile graphs.

In the Product Profile window, the drop-down list lets you select a specific profile for the
Selected Profile table. It may be the current or one of the historical profiles. This can be
useful for viewing details of a particular profile in case there are many historical profiles in
the graphs.

Figure 10-7: Product Profile History Data

Historical data can be displayed in a table view by selecting the History Table View
button.
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Figure 10-8: Product Profile History Table View

Related information

Historical data log setup
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10.6.2 Alarm and zooming
Alarms are indicated with red circles in density and temperature profile graphs.

Figure 10-9: Alarm Indication in Product Profiles

You can zoom in to view more details of the current graph by drawing a rectangular area
with the cursor around the area of interest.

Figure 10-10: Zooming a Product Profile
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10.6.3 Reports
Profile data can be exported to pdf and Excel CSV compatible format.

The report includes:

• Tank Name

• Profile data

• Deviations

Figure 10-11: Report in PDF Format

Figure 10-12: Report in CSV Format
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10.6.4 Historical data log setup
In order to view historical profile data, you need to setup logging parameters and start the
actual logging.

Procedure

1. Make sure that TankMaster WinOpi is up and running.

2. Open View → Historical View.

3. In Historical View, select the Sample Setup button.
The Sample Setup view appears.

4. In the Historical Data Log pane, select Set size of log file by no. of days and type the
desired number of days. Log size of maximum 90 days is recommended for best
performance when viewing historical product profiles.

5. In the Tank Setup pane, set appropriate sample interval. 30 minutes or more is
recommended for best performance.

6. From the list of Available blocks, select at least one block you would like to log and
use the arrow buttons to move it to Selected blocks.

7. Enter the desired Sample start time and select Start Tank.

Related information

Historical data
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10.6.5 Select historical data profiles
The Select History Data window lets you enable history data for the Product Profile view.

Prerequisites

Make sure that logging is properly setup and enabled.

Procedure

1. In the Product Profile window, select the Select History Data button:

2. In the Select History Data window, select a time period by setting appropriate From
and To dates:

3. Select Update to request data for the selected period.

4. Select check boxes for the desired dates you want to include for historical density
and temperature profiles:

5. Select OK to close the window.
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10.7 Product temperature
The Product Temperature window lets you view full containment tank product temperature
values and a selection of other tank parameters.

Figure 10-13: Tank Product Temperature

The following information is presented:

• Bar graph with Primary level value

• Vapor temperature value

• Product temperature value

• Temperature element positions in the tank

• In liquid status;

* - the element is in liquid
" - the element is not in liquid

• Values from all (1 - 32) product temperature elements

• Alarm status for all temperature elements

The Temperature Graph button allows you to view the temperature profile from top to
bottom of the tank.
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Related information

Alarm setup
View alarms
Historical data
Alarm and zooming
Reports

10.7.1 Product temperature graph
The Temperature Graph window lets you view current temperature profile. You may also
view historical temperature profiles.

The Temperature Graph window automatically scales Temperature and Level according to
current values.

The Select History Data button lets you select historical graphs to be displayed.

Temperature sensors with an active alarm are marked in red.

Temperature profiles can be exported to pdf as well as Excel®-compatible CSV formats.

Figure 10-14: Product Temperature Graph
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Product temperature history

1. In the Temperature Graph window, click the Select History Data button.

2. Enter the desired date, number of samples, and period.

3. Click OK to close the window and return to the Temperature Graph window.

Figure 10-15: Select History Data

Select check boxes for the desired Profile Data graphs.

Figure 10-16: Product Temperature Graph History Data
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10.8 Leak detection temperature
The Tank Leak Temperature window provides a standard view for leak detection
temperature elements.

It shows temperature values and other parameters:

• Leak detection temperature values for up to 32 elements

• Tags for temperature elements

• Alarm status for all leak detection temperature elements

Temperature sensors which are not configured are excluded from the Tank Leak
Temperature view.

Figure 10-17: Tank Leak Temperature
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10.9 Cool down temperature
The Tank Cool Down Temperature window provides a standard view for cool down
temperature elements. It allows you to view temperatures during a cool down process.

It shows cool down temperature values as well as other parameters such as:

• Vapor temperature

• Product temperature

• Tags for temperature elements

• Alarm status for all cool down temperature elements

Temperature elements which are not configured are not shown in this view.

Figure 10-18: Tank Cool Down Temperature
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10.10 View alarms
Alarm handling for full containment tanks is supported in Tank Master’s standard views as
well as various views designed specifically for full containment tanks.

There are a number of dedicated views for Full Containment tanks that support alarm
view:

• Tank Overview

• Tank Stratification

• Tank Rollover prediction

• Product Profile

• Product Temperature

• Leak Detection Temperature

• Cool Down Temperature

All standard alarms are supported for Full Containment tanks as well:

• Alarm summary for selected tank group

• Alarm summary for current tank alarm group

• Alarm Log

• Alarm History Log

• Standard tank views such as Tank View, Tank Inventory etc.

Alarms are also indicated in the status bar at the bottom of the TankMaster workspace.

Related information

Alarm setup
Tank parameter overview
Tank stratification
Tank rollover prediction
Product profile
Product temperature
Leak detection temperature
Cool down temperature

Operation Reference Manual
June 2021 00809-0500-5110

90 Emerson.com/Rosemount



10.11 View hardware key options
You can easily check the available license options by viewing Server Hardware Key Options.

Full Containment tank operation requires license option LNG/Full Containment Tank
Management.

Rollover prediction requires license option LNG/Full Containment Tank Management +
Rollover prediction.

10.11.1 Check hardware license options
This instruction shows how to view current Rosemount™ TankMaster license options.

Procedure

1. Ensure that TankMaster WinOpi is up and running.

2. Open Tools → View Server HW Key Info.
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